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Introduction

Version 7 is QuarkXPress’s biggest upgrade in history. In
this hour, we’ll help you get a handle on the latest creative
features such as: powerful transparency and drop shad-
ows, better support for native Photoshop files, palette
magic, advanced support for OpenType, automatic color
management across multiple projects, and synchronized
content across multiple projects. We’ll also explain the
powerful project collaboration features built into
QuarkXPress 7.

A Note About This Workbook

This presentation outline is intentionally sparse. Because
QuarkXPress 7 has not yet been released, and because the
materials deadline for this session was December 2, 2005,
I am limited to discussing features that Quark publicly
announced before December 2.

About the Presenter

Jay Nelson
For the past 13 years and 160 issues,
Jay Nelson has been the editor and
publisher of Design Tools Monthly™,
the executive summary of graphic
design news.

In addition, Jay Nelson is the author
of the upcoming book QuarkXPress 7: Up To Speed from
Peachpit Press and the upcoming video QuarkXPress 7:
New Features for Print Designers from Lynda.com.

For a complimentary copy of Design Tools Monthly, send
an email or visit our website. Email: info@design-tools.com

Website: www.design-tools.com

What’s New!

Creativity

Streamlined interface

Day-in, Day-out improvements — big efficiency
boost

Optional Single Layout mode

Append layouts from other projects

Measurements palette enhancements

= 11 palettes in InDesign
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95% of dialog box options are now in
Measurements palette.

Can behave like Apple’s Dock: show/hide entire
palette or just its Tabs

Align items to page

Left side = Item; Right side = Content

For example: define and apply color!

Control-click to change behavior of tabs

“modal”: dialog boxes still available, but
Measurements. Palette updates page immedi-
ately

Can revert to QX6 behavior

Tip: Cmd-Opt-comma <-> Cmd-Option-semi-
colon to switch tabs

Improved Space/Align

Layer items identified with layer colors

Improved tabbing: Set tabs from the measurements
palette. Now displays a vertical line to see
where the tab will be.

Palette Groups

Palette Sets

“User prefs”

Custom setup of palettes, similar to Adobe’s
Workspace

Nested folders in Prefs folder

Improved locking: Lock position and/or content, and
now you can’t change them through the
Measurements palette or Modify dialog
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User-assigned keyboard shortcuts can override native
QX shortcuts

Multiple windows

Separate or split in same window

Drag bar to resize two split sides

Buttons at end of scroll bars add new panes

Different display settings in each window

RGB, CMYK, Gray, different printer descrip-
tions, Mac vs. Windows, etc.

Now can drag and drop items between Layouts

Transparency

Applies separately to background, frame, text (even
one character)

Attribute of an item’s color, just like “Shade” – any-
where in QX6 you could apply a “Shade” you
can now apply Opacity

BUT: not an attribute of a named color

Letter-by-letter transparency, rather than item trans-
parency as in Adobe apps. Can let you fade
out letter by letter.

Can assign transparency to Style Sheets

Opacity

Attribute options

Available in several interface locations

Alpha Channels for smooth, transparent vignettes

Choose Channels from Measurements palette

Editing Channels

Drop Shadows

Synchronized angle – applies throughout a Layout

Text runaround

“Inherit opacity” lets you decrease opacity of shadow
along with item (for glass item with shadow,
for example)

“Item Knocks Out Drop Shadow” lets you have a
transparent item with a shadow, and shadow
doesn’t show through item

Flattening

Typography

Anti-aliased display: uses Quartz (GDI+ in
Windows, or whatever is used in Windows
Vista)

Support for Unicode and OpenType
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OpenType features (“Character Sets” such as Small
Caps)

Fractions

Extended ligatures

Ligatures on-the-fly

OpenType user interface

Measurements Palette

Style Sheets

Glyph Palette

Double-click to insert glyph

Favorites: store favorite glyphs from any/all
fonts. Stores and displays the font info when
you mouse over the glyph. (Favorites lets you
combine glyphs from any fonts)

Special Characters now have glyphs (flex space,
etc) so you can find/replace, and also drag
them from Glyphs palette.

OpenType settings (such as fractions) can apply to
characters, words, stories, or be applied to
Character & Paragraph Style Sheets, but NOT
to entire document

Invisibles & Special Characters

Utilities> Insert Character: Can insert Invisibles
and special characters such as Indent Here,
Page #, Nonbreaking Space, Discretionary
New Line, Right Indent Tab, En-dash, Em-
dash etc.

Can see Invisibles as an Invisibles font designed
by Ascender Corp. [MT])

Glyphs palette also shows invisibles under
“Special Characters”

Font Fallback

Normally, when you import/paste text into doc-
ument using one font that isn’t same as origi-
nal, unknown characters get replaced by
empty boxes. Now, it’s replaced by a font that
QX7 deems appropriate for that character.
The list is pre-made by Quark, but may be
modifiable by the user in a later version of
QuarkXPress. This feature is especially helpful
for Asian, Hindu & Arabic fonts.

Non-Roman glyph input now supported in QX7.
(Chinese, Korean, Japanese, Middle East, etc.)

In Passport, can now assign languages on a word-by-
word basis (useful for spell checking)



Image Manipulation

Maintain picture attributes on import. One use: can
set up picture box ahead of time, then import
photo.

QuarkVista

Basics

Collect for Output

Support for Raster EPS

Shows preview of masks

Non-destructive editing of masks: Blur a mask non-
destructively. If a mask isn’t working for your
vision in one place, blur it, see result. Can use
same image in another place, not blur mask.
Result is one file, multiple uses.

Integration

Photoshop support

Basics: why better than InDesign

Can control each layer’s blending mode and
transparency, which is much better than
InDesign.

Support for transparency in PSD or TIFF: you
can use that in place of an alpha mask (so you
don’t have to know how to create an alpha
channel in Photoshop)

Masks now transparent: smooth feathering

Choose mask from Measurements Palette

Adobe Illustrator support

Can import PDF 1.5, so can import Illustrator
native documents when they are saved with
PDF compatibility checkbox enabled, which is
the default in Illustrator.

PDF Import

Including Illustrator

Tables

Including Microsoft Excel

Basics

Including image import

Headers and footers

Split tables

Auto-resize: cell can grow as you type (it’s an
option, on a cell by cell basis)

Synchronize Items

In QX6 you could synchronize text, but in QX7 you
can synchronize every attribute.

Synchronize picture boxes, including attributes of
the box itself, and/or the content. If you
choose Content, it can include Content and
Attributes, or Content only.
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Can also include Vista effects.

Retains picture attributes when replacing picture. So,
you can synchronize empty boxes, then
import photos. Great for catalogs and multi-
media campaigns.

This is NOT like Adobe’s object styles, which don’t
synchronize content.

Shared Content

Replaces the old Library

Shared Content palette controls what gets synchro-
nized across items. You can also drag items
from the palette to the page.

You can change a shared item’s attributes directly
from the Shared Content palette, without hav-
ing to track down an instance of that item in
the Project.

You can use the Shared Content palette’s Browse but-
ton to import pictures or text directly into the
Shared Content palette without having to first
import it into a box.

Share Content across Layouts within a Project, but
not across Projects.

Output Enhancements

Print Dialog:

Instead of a horizontal row of Tabs (as in QX6),
options appear in a scrolling column of cate-
gories on left side (like Adobe products) 

Create Print Style within Print Dialog. (Instead
of Edit> Print Style...)

Can also save Export options as Output Styles for
EPS, PDF

Can now embed fonts in exported EPSes

NOTES

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

______________________________________________

____________

____________

____________

____________

____________

____________

____________

____________

A Designer’s Tour of QuarkXPress 7 page 6

MACWORLD CONFERENCE & EXPO • San Francisco, California • January 2006



Transparency Flattening asks for DPI, rather than
using an ambiguous slider

Can choose to NOT download fonts, instead using
built-in fonts in printer. Good for OpenType
large fonts.

View> Proof Output, choose any color setting (gray,
in-rip seps, your press’s setup) and preview all
the elements on the page, including previews
of imported photos.

You can use an RGB workflow now (unlike in QX6),
and QX7 will preview in those colors, based
on the ICC profile chosen in the Job Jacket or
from a menu. When printing, all colors will
output correctly. You can even choose to use
the QX4, 5 or 6 color management system, if
you need to match a legacy job.

PDF/X:

QX7 can check your document at open, save,
close, or quit and warn you for PDF/X errors
at those times, rather than only when you’re
dying to print.

The PDF/X-checking engine is from Callas
Software, who created the accepted standards
around the world.

Collaboration

Shared Layouts

This Project Only vs. All Projects: lets you use one
layout as a graphical resource elsewhere (CD
cover used on poster vs. CD cover used by
someone else on their posters; or use maga-
zine cover(s) on another thing (ad); you
design in readers’ spreads while someone else
is working in Printers’ spreads.

Composition Zones

Little brother of Shared Layouts: share a subset of a
layout. Collaborative workspace that allows
multiple people to contribute work to the
same Project. (Trevor Allen’s X-Ray article on
Composition Zones.)

Use the Marquee tool from the Tool palette to define
composition zones. Or Item> Composition
Zone> Create. You then can’t edit that zone,
but in Shared Content palette, can add it as
shared item. Choose “Make External” in
Shared Item dialog, put zone on server or
email to someone. Take a trip. Others update
zone. You return and zone updates on your
Layout. If emailed, then must place the
returned file in the same location where it
came from. QX will then automatically update
the main project.
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Also lets you use others’ layouts (ads?) in your lay-
out. Just share others’ layouts, then import
them into your layout.

Can replace EPS, PDF, etc.

File> Collaboration: under Updates tab, choose how
often to update the shared item.

Can collaborate with yourself. Create new Layout,
use shared content on new layout. “House ad”,
or logo with current tagline (as tagline
changes, other layouts change).

Quark Job Jackets

Based on open JDF format specs. Anyone can extend.

“Rules” let you define specific “do’s” and “don’ts”
such as this spot color but not that spot color.

In CS, you can share color settings (default only)
among the apps on one computer. Can’t share
easily from computer to computer. Requires
knowledge, active involvement.

In QX7, Job Jacket takes care of that. Can get specs
(or file) from printer, load into specific loca-
tion and all Projects/Tickets based on that Job
Jacket will update with color mgmt specs.

Totally open: developers/scripters can create wizards
to build Jackets.

Amazingly, you can initiate new jobs from a Job
Jacket, rather than only store metadata in Job
Jacket.

Example: a magazine publisher can give a Job Jacket
to advertisers, and advertisers can create lay-
outs from it, which limits them to using only
the color spaces, spot colors, etc., allowed by
the magazine.

A Job Jacket can contain Job Tickets. Job Tickets can
create Projects.

Digital Workflow

Color Management is vastly improved

Can be included in Job Jacket definitions

Perhaps more to come (other new features)
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